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DSI Mopho SoundEditor - Introduction

Welcome to SoundEditor, a full-featured Editor and Sound Development tool for the 
Dave Smith Instruments (DSI) Mopho synthesizer. 

SoundEditor provides the ultimate editing and sound development experience by 
displaying all Mopho Program parameters in a single, intuitive graphical interface. The 
interface allows you to view the complete details of any Program at a glance and edit any 
parameter using the mouse or computer keyboard. It allows you to see how the factory 
Programs are put together, or to freely experiment to see what you can create. Programs 
can be auditioned from SoundEditor at any time over the full range of notes (C0 - C8) 
without the need for a separate MIDI controller. 

SoundEditor is available in two versions: a Light Edition (free), and a Pro Edition. Both 
versions offer the full Program editing capabilities described above, with the Pro Edition 
offering these additional features:

  •  A Librarian that allows you to compile, organize and save Programs in Libraries 
     for easy storage and retrieval. An unlimited number of Library fi les can be
     created.
  •  A Program Genetics function, where you can create entire banks of new sounds
     from any two source Programs.
  •  A Morpher function, allowing you to smoothly transition (morph) between any
     two Programs as you audition the sound in real time.
  •  Phantom Program Banks, which allow you to have up to 16 virtual Program
     banks available at any time.
  •  A Snapshots function that allows you to confi gure multiple UNDO points while
     editing a Program.
  •  Enhanced Sequencer functionality that allows you to create, modify, and store
     an unlimited number of Sequencer fi les that can be applied to any Mopho
     Program.

This manual describes the functions and features found in both the Light and Pro 
Editions. To get the most from SoundEditor, please read this User Guide carefully.

We hope you enjoy using SoundEditor for your Mopho synthesizer!

Online support for this product is available at:
http://www.soundtower.com/Mopho

1. Introduction

1.1 Support
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1.2 About this Manual

Throughout the manual, screen shots of the SoundEditor application are shown for 
illustrative purposes. These views are based on SoundEditor for the Macintosh, although 
similar views will be observed if you are using SoundEditor on a PC. When any 
signifi cant variation in the appearance or operation of SoundEditor occurs between the 
Mac and PC platforms, the differences will be described.

Throughout this document you will see icons that provide additional information:

-  This icon indicates an important note concerning the operation
    of the SoundEditor program.

- This icon indicates a helpful or productive tip.

No special software installation is required. SoundEditor is a standalone program 
designed to run on Windows XP or Vista, or a Macintosh (OSX 10.3 or higher).

The SoundEditor application requires:
  - 20 MB Hard Drive space
  - 256 MB RAM (min.)
  - 1024 x 768 minimum screen resolution (1400 x 900 recommended)
  - a MIDI interface or USB connection

1.3 Installation/Requirements



              

         

5

DSI Mopho SoundEditor - Introduction

6

DSI Mopho SoundEditor - Starting Up

1.4 Before You Begin

To get the most out of this program you should be familiar with the operation of the 
DSI Mopho. The Mopho is complex musical instrument with an amazing array of 
programmable features. The Mopho Operation Manual is the essential source for Mopho Operation Manual is the essential source for Mopho Operation Manual
descriptions of the instrument and its operation, and is recommended reading for all 
users. Although SoundEditor can be an invaluable resource to aid in understanding 
the operation of the Mopho synthesizer, it is not a substitute for reading the Mopho 
documentation.

This User Guide will take you through the steps to confi gure SoundEditor to work 
with your DSI Mopho. The Starting Up section should be followed fi rst to get the 
hardware properly connected and running with the SoundEditor application. From 
there you can freely explore, audition and edit the hundreds of Programs that Mopho 
offers, create new Programs, organize and rearrange Programs to suit your needs, etc. 
Have fun!

1.5 Overview
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2. Starting Up

Set up the Mopho according to the Mopho Operation Manual (refer to the Getting 
Connected section on page 3). Connect the Mopho to the your computer interface Connected section on page 3). Connect the Mopho to the your computer interface Connected
using both MIDI In and MIDI Out connectors (both connections must be in place for 
proper operation of the software).

After making the MIDI connections between the Mopho and your computer, power 
up the Mopho and launch SoundEditor. As the SoundEditor program starts, a splash 
screen will appear briefl y.

If you are using the Light Edition of SoundEditor, the splash screen will be replaced by 
the Controls Window (also referred to as the Main Window throughout this Guide). At 
this point, users of the Light Edition should skip ahead to the MIDI Setup section on
page 8.

If you are using the Pro Edition of SoundEditor, the splash screen will include a 
‘Registration’ screen as shown below:

2.1 Getting Connected

This chapter describes the steps to connect and confi gure SoundEditor on your computer.
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The registration screen offers two options: Demo Mode and Register Online. 

Selecting Demo Mode will put the program into demo mode (unregistered), limiting fi le 
and SysEx operations, but still allowing you to get an idea of what the Pro Edition offers. 
Demo mode gives you unlimited time to explore all of SoundEditor’s features with the 
following limitations:

• Real-time editing from the Controls Window (disabled)
• Loading and Saving all fi les (disabled)
• Writing presets to the Mopho (disabled)
• Some Librarian features, Program Genetics
  and Morpher auditioning (disabled)
• Snapshots features (disabled)

When you re-run the program, you’ll need to select Demo Mode again. This will
continue until the program has a valid registration. There is no limit to the number of 
times the program can be run in demo mode.

If you click on the REGISTER ON LINE button, SoundEditor will attempt to launch 
your browser and connect you to the Dave Smith Instruments online store, where you 
can purchase a registration code to unlock the software. You will need a working internet 
connection to complete this operation. Once purchased, registration codes are issued via 
email, and you may experience a few hours delay in receiving it.

Once you have received your registration code, enter the information exactly as it 
appears, and click the Enter Code button:

A ‘Thank You’ splash screen will then appear. Click OK to dismiss the screen and the OK to dismiss the screen and the OK
Main window will then appear. Registered versions of SoundEditor will display the user’s 
name in the splash screen at start-up.
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2.2 The MIDI Setup

If you are working with SoundEditor for the fi rst time, you’ll need to confi gure the 
program for MIDI communication with the Mopho hardware. Once you do this, 
SoundEditor will remember the confi guration until you change it.

Click on the MIDI menu and select ‘MIDI Setup’:

Your MIDI Setup window will likely show different MIDI Input and
MIDI Output Port information.

The MIDI Setup window will appear, displaying the available MIDI Port connections 
on your computer:
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In the MIDI Setup window, select the MIDI IN and OUT ports that the Mopho is 
connected to, and set the MIDI Channel to match the MIDI channel on the Mopho. 
Once the proper ports and MIDI channel are selected, you should see the current 
Mopho software version at the top of the MIDI Setup window as shown. This 
confi rms that SoundEditor is communicating with the DSI Mopho. 

After making the appropriate MIDI connections, click on the OK button to dismiss OK button to dismiss OK
the window. You can safely ignore the MIDI In Keyboard Controller tab for now. 
Information on the use and confi guration of the MIDI In Keyboard Controller and 
Virtual Ports (Virtual Ports only appear in Macintosh versions of SoundEditor) is 
provided in Appendix D.

The MIDI Channel menu is duplicated in the Global Settings window for 
convenience. You can use either menu to set the MIDI Channel. 
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3. SoundEditor Menus

The menus in the main window of SoundEditor allow you to select various functions, 
views, fi le storage options, editing commands, MIDI confi gurations, and much more. A 
description of the main window menus appears below. Note that menus in the Pro Edition 
will offer more features and functions than the Light Edition. 

MophoPro:

The MophoPro menu is where you select Preferences, 
get information (‘About’), perform OS Updates, and 
Hide or Quit the SoundEditor application.

Information on confi guring Preferences appears later in 
this chapter.

Information on updating the Mopho’s Operating System 
appears in Appendix E.

File:

The File menu allows you to Load or Save 
single Mopho Programs, and access the 
Program Banks, Bank Manager/Librarian 
and Phantom Program Banks functions.

The Bank Manager/Librarian is covered in 
section 8.

The Phantom Program Banks function is 
covered in section 12.

Bank Manager/Librarian and Phantom Bank functions are not available 
in the Light Edition, and do not appear in the LE’s FILE menu.
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The Options menu provides access to the Program 
Genetics and Morpher functions, as well as display 
a virtual keyboard (V-Piano) that you can use to 
remotely play Mopho Programs. 

Program Genetics is covered in section 9.

The Morpher is covered in section 10.

The V-Piano is covered in section 13.

MIDI:

The MIDI menu provides access to the Global 
Settings and MIDI Setup windows, as well 
as perform Receive and Transmit program 
operations.

Global Settings is covered in section 6.

Information on the MIDI Setup appears in 
Appendix D.

Options:

Edit:

The Edit menu provides access to the Control and 
Sequencer Windows, as well as commands to perform 
Copy, Paste, Write, Rename and Initialize operations.

The Control Window is covered in section 5.

The Sequencer function is covered in section 7.

Program Genetics and Morpher functions are not available in the Light 
Edition, and do not appear in the LE’s OPTIONS menu.
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Help:

The Help menu allows you to access additional assistance online.

3.1 Confi guring Preferences
There are several options for choosing how the computer mouse will control specifi c 
functions in SoundEditor. These options are located in the Preferences window, which is 
accessed from the MophoPro menu.

The Preferences Window is shown below. Menu options in this window allow you to 
choose how the mouse’s scroll wheel will function, and how the on-screen knobs will 
react to mouse movements:

Once Preference settings are chosen, they will remain ‘as is’ until you change them.

Snapshots:

The Snapshots menu allows you to access the 
Snapshots function and/or add a snapshot of the 
currently edited Program.

Snapshots is covered in section 11.
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The methods described here apply to all windows in SoundEditor.

4. Parameter Selection in SoundEditor

SoundEditor relies on a number of methods to select and adjust parameter values in 
edit screens. These methods include selecting from drop-down menus, moving sliders, 
rotating knobs, dragging to increment/decrement values, etc.  This section will describe 
the various ways to select and manipulate Mopho parameter values in SoundEditor.

In any window, a parameter fi eld with a downward facing arrow indicates that there 
are usually two or more choices available for that parameter or function. Clicking on 
the downward arrow will produce a contextual menu of options as shown. To make a 
selection, simply move the cursor down through the menu and click on the desired item.

4.1 Selecting and Adjusting Parameters

PERFORMANCE TIP:  Lengthy contextual menus in SoundEditor can be navigated 
using either the mouse cursor or the scrollable mouse wheel. To effi ciently 
navigate through lengthy menus (like Modulation Destinations), try combining both 
navigation methods to quickly locate desired items.

LED controls in SoundEditor windows are toggled ON or OFF simply by clicking on 
them. An LED will appear lit when ON, and dimmed when OFF:
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‘Radio’ buttons, like those found in the Librarian window, toggle between two mutually- 
exclusive operational modes (‘Multi-Select’ or ‘Drag and Drop’ shown). Selecting one 
mode automatically de-selects the other:

Checkboxes, like those found in the Librarian window, are used to turn operational modes 
ON or OFF:

Slider controls are adjusted simply by clicking and dragging the slider in the direction 
you wish to go. Knobs, however, are adjusted by clicking on the desired knob and 
dragging the cursor around the knob in a rotary fashion:

An alternate method of knob control (‘LINEAR’) is available in SoundEditor’s 
‘Preferences’ pane. When LINEAR control is selected, clicking on a knob and 
moving the cursor up or down will rotate the knob to the left or the right. In either the 
CIRCULAR or LINEAR control mode you can also use the mouse scroll wheel to 
make fi ne knob adjustments by placing the cursor directly on the desired knob and 
scroll up or down.
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In the Controls Window, the ADSR parameters for Amp or Envelope 3 can be changed 
using the ADSR knobs or by grabbing and dragging the associated parameter handle in 
the envelope display as shown: 

As you move the envelope’s handle, updated parameter values appear in the display. At 
the same time, the corresponding knobs (in this case, ‘Decay’ and ‘Sustain’) are updated 
to refl ect the new values.

If you are using a two-button mouse, you’ll fi nd that right-clicking in various lists and
menus in some windows will bring up a contextual menu of useful functions/commands 
like the examples shown:

4.2 Alternative Controls

These contextual menus allow you to 
perform common operations such as 
Copy, Paste, Cut, Delete, Rename, Assign 
Categories, etc. These commands are 
duplicated in the various SoundEditor 
menus.  
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The following keyboard keys can be used to navigate any list:

• Pressing the PAGE UP or PAGE DOWN keys scrolls the list in blocks of Programs.

• The UP and DOWN keys will scroll one preset at a time, up or down respectively.

• Pressing the END key moves to the end of a list, while the HOME key returns 
   to the beginning of a list.

Program lists in SoundEditor windows can be navigated using the list scroll bars, the 
scrollable mouse wheel, or the keyboard.

4.3 Scrollable Lists
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When you launch SoundEditor, the program displays the Controls Window (AKA, the 
Main Window), shown below. The Controls Window provides on-screen editing control 
for every parameter that makes up a Mopho Program except for Sequencer programming 
functions, which appear in a separate window.

5. The Controls Window

In addition to the knobs, LEDs and selection menus in the Control Window, other 
window components include:

1.  Toolbar buttons to access frequently-used functions and commands.

2.  Program Name Display. The Program Name Display shows the name, the assigned
sound category, and the memory location of the currently selected Program.

3.  Banks button, used to access Programs from any of the three Mopho Banks.

4.  Transparency button, used to control the transparency of the window.

Since MIDI control messages are transmitted bi-directionally, you can perform edits 
either from SoundEditor’s Controls Window or from the Mopho hardware - both will 
be updated simultaneously.
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5.1 Toolbar

The Toolbar provides convenient access to frequently-used SoundEditor commands and 
functions. Descriptions of each Toolbar button follows.

The Receive button receives the current program from the Mopho hardware, allowing 
you to refresh after making changes. This button resynchronizes SoundEditor with the 
Mopho if you have been editing a program offl ine using the Mopho controls.

The Send button sends the current edited SoundEditor program to the Mopho hardware, 
allowing you to refresh after making edits. This button resynchronizes the Mopho with 
SoundEditor if you have been editing a program offl ine using SoundEditor.

The Snap button copies the current program to the Snapshots window. This button 
duplicates the action of selecting ‘Add Snapshot’ from the Snapshots menu. Snapshots 
are covered in section 11.

The Write button produces a window (shown below) allowing you to write the current 
Program to the Mopho hardware. In this window you can change the name of the 
Program, assign a category, and select the memory location where the Program will be 
written. The Write button duplicates the action of selecting ‘Write Program’ from the 
Edit menu.

The Toolbar in the Light Edition of SoundEditor does not include buttons for SNAP, 
MORPHER, or GENETICS, as these functions are not included.

The Sequencer button opens the Sequencer window. This button duplicates the action of 
selecting ‘Sequencer’ in the Edit menu. Sequencer functions are covered in section 7.
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The Global button opens the Global Settings window, where you control the global 
settings for the Mopho. This button duplicates the action of selecting ‘Global Settings’ 
from the MIDI menu. The Global Settings window is covered in section 6.

The Morpher button opens the Morpher window. This button duplicates the action of 
selecting ‘Morpher’ in the Options menu. Morpher functions are covered in section 10.

The Genetics button opens the Program Genetics window. This button duplicates the 
action of selecting ‘Program Genetics’ in the Options menu. Program Genetics is covered 
in section 9.

The V-Piano button open the virtual piano screen for remotely playing the Mopho 
hardware from your computer. This button duplicates the action of selecting ‘V-Piano’
in the Options menu. The V-Piano is covered in section 13.



              

         

19

DSI Mopho SoundEditor - Controls Window

20

DSI Mopho SoundEditor - Controls Window

5.2 Program Name Display

The Program Name Display (shown below) shows the name of the currently selected 
Program (‘RetroMoPho’), the location of the Program (bank C, location 046), and the 
category of the Program (‘Sequence’):

To change the Program name, double-click inside the Program Name Display. This will 
produce a window where you can enter a new name (up to 16 characters in length), and 
also select or change the Program Category, if desired:

Program names may include upper and lower case characters as well as 
numbers and most punctuation marks.

Clicking on the OK button will send the new name to SoundEditor and to the Mopho’s OK button will send the new name to SoundEditor and to the Mopho’s OK
edit buffer, but will not automatically store the name. To store the new name you must 
write the edited sound to the Mopho using the WRITE command.
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You can also select a category from the Program Naming window by clicking on the 
blue text in Program Category fi eld. This will produce the same contextual menu as 
shown above:

5.3 Assigning Program Categories

There are several ways to assign a category to a Program. This can be done from the 
Program Name Display, from the Program Naming window, or by right-clicking in the 
‘Category’ column of the User Bank (part of the Bank Manager/Librarian).

To assign a category from the Program Name Display, click in the Category section 
of the display (the upper right part of the Name Display window). This will produce a 
contextual menu of categories to select from:
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5.4 The Banks Button

Clicking on the Banks button produces a window displaying the all of the Programs in all 
three banks as shown below. Clicking on any Program in any bank will load that Program 
into SoundEditor’s Controls Window and send that Program to the Mopho’s Edit Buffer.

The BANKS window defaults to displaying factory Programs. If you’ve 
changed these Programs, renamed or rearranged Programs, or created new 
Programs in the Mopho hardware, you may wish to load all Mopho banks into 
SoundEditor before you begin an editing session. To perform this step, refer to 
the ‘Bank Manager/Librarian’ section.
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5.5 The Transparency Button

The circular ‘T’ button at the top of the Control Window is the Transparency button, 
which is used to access the window transparency function:

Clicking on the ‘T’ button produces a slider that you can use to adjust the transparency of 
the window from 100% (normal view) to as little as 10% (nearly invisible):

After adjustment, clicking anywhere in the window will remove the slider from view and 
keep the window transparency at the current setting. To return to a the normal view, click 
on the ‘T’ and adjust the slider back to 100%. 

The transparency always resets to the normal view (100%) every time SoundEditor is 
launched.
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6. Global Settings
The Global Settings window is accessed by clicking the Global button in the toolbar or 
by selecting “Global Settings” from the MIDI menu. 

The Global Settings window displays and provides user control of the Mopho’s global 
settings, including transposition control, tuning, clock, MIDI parameters and parameter 
send/receive functionality. 

Shown below, the Global Settings window provides control of:

•  Master Transpose (-12 to +12)
•  Master Fine Tune (-50 to +50)
•  Midi Channel (All, 1–16)
•  Midi Clock Select (Internal, Internal with Send, External

and External with Send)
•  Midi Sysex Send/Receive On/Off
•  Midi Controller Send/Receive On/Off
•  Parameter Send (NRPN, CC, OFF)
•  Parameter Receive (All, NRPN Only, CC Only, OFF)
•  Audio Out (Stereo, Mono)
•  MIDI Out Select (MIDI Out, MIDI Thru)

The MIDI Channel menu is duplicated in the MIDI Setup window for 
convenience. You can use either menu to set the MIDI Channel. 
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7. The Sequencer Window

The Sequencer window allows you to program/adjust the four Mopho sequences, select 
the modulation destination of each sequence, and set the overall tempo and clock divide 
parameters. Additionally, a Sequence Templates function allows you to copy sequences 
from other programs and apply them to any one or all four sequences, and a Sequence 
Functions drop-down panel allows you to adjust the length of each sequence, create 
pitched sequences from preloaded sequence data, and alter the sequence data in musically 
useful ways (Sequence Templates and Sequencer Functions are only available in the Pro 
Edition).

SoundEditor’s Sequencer Window allows you to program and adjust all four Mopho 
sequences in a user-friendly graphical environment. The Sequencer window is displayed 
by clicking the Sequencer button in the toolbar or by selecting “Sequencer” from the 
Edit menu. The Sequencer window is shown below.
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7.1 Display Mode

The Display Mode control affects the way the cursor is used to adjust each of the 16 
sequence control bars. There are two display modes: Sliders and Pen. These options are 
selected from the Display Mode menu:

When Slider mode is chosen, sequence steps are individually adjusted by clicking and 
dragging on sequence bars, one at a time. Slider mode is the best choice for sequences 
that will control oscillator pitch, or anytime a precision adjustment is required.

When Pen mode is chosen, the cursor acts much like a magnet. As you drag the cursor 
across the sequence bars, the height of each bar will follow the placement of the cursor, 
allowing you to adjust the overall shape of the sequence as if drawing a line or curve. 
It allows you to easily create evolving ‘envelope-like’ sequences. Pen mode is not as 
precise as slider mode, but is a good choice for sequences that are programmed to provide 
changes over time.

Once set, the Display Mode control setting remains ‘as is’ until you change it again.
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7.2 Sequence Destination

Below each of the four Sequence labels is a ‘DESTINATION’ fi eld that displays the 
modulation destination for each sequence. Clicking on this fi eld produces a menu 
displaying the 45 possible modulation destinations (or ‘OFF’), allowing you to change 
the modulation routing for each sequence:

7.3 Reset Button
The Reset button resets the sequence step bars to 
zero values for the selected sequence. This is a 
quick way to zero all 16 sequencer steps.
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7.4 The Functions Button

Just below the Reset button is the Functions
button. Selecting the Functions button opens 
a Function panel (this will be a drawer on a 
Macintosh or a window on a PC) that allows you 
to access additional sequencer functions. These 
include adjusting the length of each sequence, 
options to create pitched sequences from pre-
loaded sequence data, and options to alter the 
sequence data.

The Functions button is only available in the Pro version.

In the Sequencer Function panel, the Seq buttons that appear on the far left (Seq1 thru 
Seq4) are used to select the specifi c sequence that will be affected by the panel functions. 
The ‘From Step’ and ‘To Step’ sliders allow you to specify the range of steps that will be 
affected within the selected sequence:

In the fi gure above, for example,  Sequence 4 has been selected with a step range of
5 - 10. This means that any function chosen from either the Chords or Functions lists 
will only affect steps 5 thru 10 in Sequence 4, and no others. Also, note that the color of 
the selected step bars is different from the others - this provides a visual indication of the 
sequence steps that will be affected by the chosen functions.



              

         

29

DSI Mopho SoundEditor - Sequencer Window

30

DSI Mopho SoundEditor - Sequencer Window

The Chords list allows you to select from preloaded ‘chord’ data for major and minor 
chords, and several major and minor sevenths for each sequence. Although the Mopho 
is a monophonic instrument, selecting from the Chords list gives you a sequence of 
arpeggiated notes that makes up the chosen chord structure (from as few as two notes to 
as many as six). The selected note sequence will be repeated until the end of the sequence 
or until the end of the specifi ed range is reached:

If the modulation destination of a chorded sequence is ‘Oscillator Frequency’ (Osc 1 
Freq, Osc 2 Freq or Osc All Freq), the sequence will be displayed as a series of MIDI 
notes:
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The root note of a chorded sequence is based on the fi rst step of the selected sequence. 
For example, in the previous fi gure the fi rst step (step 5) happened to be ‘G#’, so a major 
chord based on a ‘G#’ was generated. To get a chord sequence based on a different root, 
simply adjust the fi rst sequence step to the desired note then click one of the Chord 
buttons. 

Using the previous fi gure as an example, a ‘C’ major sequence is generated by adjusting 
the fi rst note (step 5) to a ‘C’ before clicking on the MAJOR chord button:

For more information, refer to Appendix B for a list of chord structures and Appendix C 
for details on sequencer note values.
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Appearing on the far right of the panel 
are additional controls to modify the 
selected sequence. These include an 
executable Functions list, UNDO and 
DONE buttons, and a Control Adjust 
arrow tool.

The Functions list provides commands to copy, paste and modify the selected sequence. 
Commands include:

Copy: Copies the selected sequence.

Paste: Pastes to any selected sequence.

Reverse: Reverses the sequence order within the specifi ed step range.

Invert: Inverts all values within the specifi ed step range. Zero values become
Resets and vice versa.

Randomize: Randomizes all values within the specifi ed step range. Repeated
selecting of the Randomize function creates a new series of random sequence
values.

Randomize Q: Works like Randomize, but automatically adjusts step values
up or down to real note values.

Step Up: Creates a sequence of incremental positive values based on the fi rst
value in the range. For example, if the fi rst step value is 0, Step Up will create
a series of values where the second step value will be 1, the third 2, etc. If the
fi rst step value is 45, then the second will be 46, the third 47, etc.

Step Q: Works like Step Up, but increases the step values by 2. If the fi rst step
value is 10, Step Q will create a series of values where the second step value
will be 12, the third 14, etc.

The Control Adjust arrows raise or lower the selected sequence value by ‘1’ for each 
click of the control. Holding the control button instead of clicking provides for rapid 
adjustment of the sequence values.

The UNDO button offers multiple levels of undo. You can undo any chord or function
selection back to the point at which you started.

The DONE button closes the Function panel..
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At the top right of the Sequencer 
Window are the Tempo and Clock 
Divide function controls. To make 
adjustments, simply click and rotate 
the control for Tempo, or click on 
the downward arrow in the Clock 
Divider fi eld for a contextual menu 
of clock divider selections.

Tempo is continually adjustable 
from 30 to 250 BPM.

Clock Divide is adjustable in 
increments from Half Note through 
64th Note Triplets.

7.5 Tempo and Clock Divide
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Sequence Templates provide a way to copy and paste 
sequences from other Programs into the current 
Program, and load/save sequence fi les on your 
computer.

The operation of the Sequence Template function 
is managed with the three buttons at the top of the 
Sequence Template window:

The Add button adds the sequence from the current 
Program to the list.

The Load From...  button produces a drop-down 
menu that allows you to load sequences from banks 
A, B or C, or from a File saved to your hard drive.. 
There is also a selection here to clear the list.

Selecting Load From... A File produces a window 
that displays all the fi les on your computer. Only 
those fi les having an ‘.m_s’ extension are valid 
template fi les that can be loaded - all other fi le types 
will be ignored.

The Save button produces a ‘Save’ window where 
you can name the Sequence Template and select the 
storage volume for the fi le.

To load a Sequence Template to the current Program, 
simply select a Sequence from the list and click on 
the ‘Send’ arrow on the right. The four sequences 
that make up the selected Sequence Template are 
sent to the Mopho’s Edit Buffer, and they also appear 
in the Sequence Window, where they can be edited 
using the sequence step bars, buttons and functions.

By default, Sequence Templates are sorted 
numerically, but they can also be sorted
alphabetically (A–Z) by clicking on the 
‘4 x Sequence’ column header, as shown at left. 
A second click on that header will reverse the sort 
order (Z–A). Clicking on the ‘No.’ column header 
switches the sorting order back to the numerical 
listing (1, 2, 3...), and a second click on that header 
reverses the sorting order (... 3, 2, 1).

7.6 Sequence Templates
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8. Bank Manager/Librarian
The Bank Manager/Librarian is accessed by selecting the ‘Bank Manager/Librarian’ 
option in the File menu. The Bank Manager/Librarian lets you organize and store an 
unlimited number of Mopho Programs. You can also have as many Library fi les on your 
computer as you wish. The Librarian provides 24 sound categories to organize your 
Mopho sounds and have them available for immediate use. For convenience, these sound 
categories have already been defi ned, but all categories can easily be renamed according 
to your needs. A view of the Bank Manager/Librarian window is shown below. 

The main components of the Bank Manager/ Librarian include:

1.  Toolbar buttons to access frequently-used functions and commands in the Bank 
Manager.

2.  ‘Radio’  buttons and checkboxes to select operational modes in the Bank Manager.

3.  User Bank and Bank buttons (Banks A, B, C)

4.  Toolbar buttons to access frequently-used Librarian functions and commands.

5.  List of categorized Library Programs 

6.  Predefi ned Library categories (24 total)
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8.1 Bank Manager Toolbar

The Bank Manager Toolbar (shown below) provides convenient access to frequently-
used Bank Management commands and functions. Descriptions of each Toolbar button 
follows.

The Load button allows you to load a bank of Programs into the User Bank. Selecting 
Load produces a ‘Load Mopho Program Bank’ window that allows you to locate and 
select Mopho Program Bank fi les to load. Only those fi les having an ‘.m_b’ extension are 
valid Program fi les that can be loaded - all other fi le types will be ignored.

The Save button allows you to save the current User Program Bank. Selecting Save 
produces a ‘Save As...’ window where you can name the Program Bank and select the 
storage volume for the fi le.

The Receive button initiates the process to receive a bank of Programs from the Mopho 
hardware. Selecting Receive produces a ‘Receive Program Banks’ window. You will 
need to click on the Start button to begin the actual transfer process. The bank that is 
requested from the Mopho hardware will be the currently selected User Bank (A, B, or 
C). In other words, if the User Bank is displaying Bank A when you initiate the receive 
command, the Mopho hardware will transmit the fi rst bank (Bank 1) to SoundEditor 
regardless of its current bank setting. 

The Transmit button initiates the process to transmit a bank of Programs from the 
current User Bank (A, B, or C) to Mopho hardware. Selecting Transmit produces 
a ‘Transmit Program Banks’ window. You will need to click on the Start button to 
begin the actual transfer process. The transmitted bank (A, B, or C) will go into the 
corresponding bank (1, 2, or 3) on the Mopho hardware. In other words, if the User Bank 
is displaying Bank B when you initate the transmit command, the Mopho hardware will 
receive that data into Bank 2  regardless of its current bank setting. 

The Load, Save , Receive and Transmit button functions duplicate commands found in 
the menus.

Lastly, although not related to the controls described above, the Transparency button 
allows you to adjust the transparency of the Bank Manager/Librarian window. 
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8.2 ‘Radio’ Buttons and Checkboxes

‘Radio’  buttons and checkboxes are used to select operational modes in the Bank 
Manager window. These controls appear just below the Toolbar in the upper left corner
of the Bank Manager window:

Here’s how the buttons and checkboxes function:

The Use Bank Data checkbox is part of the User Program Bank functions. When Use 
Bank Data is unchecked (disabled), selecting a preset from the User Program Bank 
switches the Mopho to the corresponding preset. This guarantees synchronization 
between the hardware and SoundEditor. When Use Bank Data is checked (enabled), 
the selected preset data from the User Program Bank is sent to the Mopho edit buffer for 
editing and audition. This feature helps to browse through presets in the User Program 
Bank without the need for dumping the entire bank to the hardware.

When Use Bank Data is enabled, Tempo and Clock Divide data is not sent 
with the program data. If a sequence is playing when you select a new 
program, you will hear the new program’s sound, but it will be played at the 
tempo of the original program. This can be used to quickly audition new 
sounds/sequences at pre-determined tempos.

Despite its location in the window, the Auto Dump checkbox is actually part of the 
Librarian function. When the Auto Dump checkbox is checked (enabled), a selected 
preset from the Librarian Program list is automatically sent to the Mopho edit buffer for
editing/audition. When Auto Dump is unchecked (disabled), no data is sent.

The Multi Select and Drag and Drop radio buttons are used to defi ne the operation of 
the cursor in the Bank Manager/Librarian window. Drag and Drop permits conventional 
cursor operation, allowing you to freely drag and drop presets between the current 
User Bank and the Librarian. You can add the Shift and other modifi er keys to make 
multiple preset selections, which can be groups of Programs, non-adjacent selections, or 
a combination of both. Multi Select mode locks the cursor into ‘Select’ mode, allowing 
you to select groups of Programs. This mode can be useful for large amounts of group 
moves because it restricts the operation of the cursor to just making selections, preventing 
accidental dragging of presets out of the User Bank or Librarian. In Multi Select mode, 
Programs are moved between the User Bank and Librarian using the large Copy buttons. 

Lastly, although not part of the operational mode controls described above, the Edit
button takes you to the Controls window, where you can edit the currently selected 
Program.
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One thing to keep in mind while working 
in the User Bank is that the Bank buttons 
interact with the Use Bank Data checkbox, 
meaning that SoundEditor will switch 
to the Mopho bank/location and acquire 
the Program data from the Mopho (when 
Use Bank Data is unchecked), or send 
the selected Program data to the Mopho’s 
current preset (when Use Bank Data is 
checked).

8.3 The User Bank

The User Bank (and associated Bank 
Manager controls) allow you to you load, 
save, transmit, receive, and edit banks of 
Mopho Programs. Program banks are loaded 
into the User Bank either from the Mopho, 
from a stored bank, or from one of the 
three factory banks built into SoundEditor. 
The User Bank has three banks, labeled 
A-C, corresponding to the three Program 
banks in the DSI Mopho. Programs in the 
User Bank be selected individually, as 
a group, or randomly (non-adjacent), to 
allow for convenient rearrangement and 
reorganization.

The User Bank list offers several options for 
sorting Programs. By default, Programs are 
sorted numerically as they appear in the
bank, but Programs can also be sorted
alphabetically or by Category. To sort 
alphabetically (A-Z), click on the ‘Program’ 
column header at the top of the listing, as 
shown. A second click on the ‘Program’ 
header will reverse the order (Z-A). 

To sort Mopho Programs by Category
(A-Z), click on the ‘Category’ column 
header. A second click on the ‘Category’ 
header will reverse the order (Z-A).

Clicking on the ‘No.’ column header 
switches the sorting order back to the 
numerical listing.
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8.4 The Librarian Panel 

The Librarian lets you store an unlimited number of Mopho Programs, and allows you 
organize them in any fashion. You can also have as many library fi les on your computer 
as you wish. The Librarian provides 24 sound categories to organize your Mopho sounds 
and have them available for immediate use. The categories are pre-defi ned, but any 
category can be renamed should you need to. A view of the Librarian panel is shown 
below. Sound categories are displayed on the left along with two large Copy buttons. A 
list of the Mopho Programs appears on the right, and buttons for library fi le functions are 
at the top.

The currently selected (active) sound category is indicated by boldface type and a 
triangle to the left of the name. In the fi gure above, Library (Not Assigned) is the active 
category, and contains 14 Programs; these Programs are listed in the window on the right. 
If the number of Programs exceed the amount that can be displayed within this window 
(about 22 Programs) SoundEditor will add a scroll bar to the window. 
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To switch to a different category, simply click on the desired category name:

Navigating a Librarian Category Program list is exactly like navigating any other list, 
using either the mouse or the keyboard. Options for changing the sort order of Programs 
is the same as for any other list:
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8.5 Librarian Toolbar

The Librarian Toolbar (below) provides convenient access to frequently-used Librarian 
commands and functions. Descriptions of each Toolbar button follows.

The Add Current Program button adds the current Program from the User Bank to the 
active sound category. Note that new entries are always added to the end of the list, so if 
you have a lot of Programs in a particular category, you may have to scroll down to see 
the new entry.

The New button allows you to create a new Library. After selecting New, you will get a 
message dialog box asking if you wish to save the existing library. To save the existing 
Library, clicking the OK button in the message box will present you with a ‘Save As...’ OK button in the message box will present you with a ‘Save As...’ OK
window where you can name and save the current Library fi le to the specifi ed storage 
location. After the ‘save’ operation is complete, you will have an empty (new) Library. 
If you decline to save the existing Library, the contents of the existing library (all 32 
categories) will be cleared, leaving an empty Library. 

The Save button allows you to save the current Library. Selecting Save produces a ‘Save 
As...’ window where you can name the Library File and select the storage location for the 
fi le.

The Load button allows you to load a library fi le into the Librarian. Loading a library 
fi le is just like loading a bank fi le, but with a difference – library fi le names have the 
extension .m_l.

The Add Current Program, New, Save and Load buttons duplicate commands found in 
the menus.

Finally, although not part of the operational controls described above, the Edit button 
takes you to the Controls Window, where you can edit the Library’s currently selected 
Program.

You can load a new library into an existing library to combine the presets of each. 
You can also combine presets from different banks using the ‘Load from User 
Bank Data’ command.
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8.6 Adding Programs to the Library

While the Add Current Program button is one way to add an entry into the Library, it 
only adds a single Program at a time to the currently selected Category. To copy groups of 
Programs from the User Bank into the Library, use the right-facing Copy button:

In the screen shot above, Programs A010 through A015 were selected from the User 
Bank. Clicking on the right facing Copy button added those six programs to the selected 
Library category (“Res Lead”).

Occasionally, you may wish to add single Programs or groups of Programs to multiple 
Library categories. In this case, selecting and dragging the Program(s) from the User 
Bank into the Library offers a direct and convenient alternative to using the Copy button:

In the screen shot above, Program A009 was selected from the User Bank and is shown 
being dragged into the Library’s ‘Res Bass’ Category. When Programs are moved by 
dragging, only an outline box is displayed as they are being moved. Note that you can 
drag a Program (or group of Programs) into any Category by this method.
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8.7 Moving Programs between Categories

Mopho Programs can be moved between Categories using several transfer methods. The 
fi rst method is to set the red Transfer Arrow (click in the Transfer Arrow column to set 
the arrow to point to the desired Category), select the desired Program and then click on 
the Arrow.  The Program will transfer from the current Category to the new Category. In 
the screen shot below, the Program ‘Triangular’ is being transferred from the ‘Res Lead’ 
Category into the ‘Soft Lead’ Category:

The second method involves simply dragging the desired Program from the current 
Library Category into another Category. In the screen shot below, the Program ‘Feedback 
Sync’ is being dragged into the Library’s ‘Res Lead’ Category. As mentioned previously, 
when Programs are moved by dragging, only an outline box of the Program is displayed 
as it is being moved. 

Either method can be used to move single Programs or groups of Programs.
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8.8 Copying Programs to the User Bank

Copying Programs from the Library to the User Bank basically involves the same 
methods as copying Programs into the Library from the User Bank: you can either use the 
large Copy button, or you can simply drag the Program (or group of Programs) into the 
User Bank. Note, however, that either method requires that you fi rst specify a location in 
the User Bank to copy the Program(s) to.

The screen shots below will illustrate the process. First, in the User Bank, we select 
location A022 as the ‘copy to’ location. Next, in the Librarian, we select ‘Feedback Sync’ 
as the Program to be copied:

Now we click on the left-facing Copy button. This produces a message box, which asks 
for confi rmation of the copy operation and provides message indicating that when the 
Program is copied, it will be written to the User Bank and also to the Mopho hardware at 
the selected location. The message box offers three choices: Cancel, NO and OK:
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If you are uncertain about proceeding at this point, you should select Cancel and the copy 
operation will be stopped. If you select NO, then the Program will be copied to the User 
Bank but it will not be sent to the Mopho. This is handy if you are simply rearranging will not be sent to the Mopho. This is handy if you are simply rearranging will not
Programs in the User Bank but do not wish to affect the Programs in the Mopho, Finally, 
if you select OK, then the full Copy/Write process wil execute. The Program will be 
copied to the User Bank and written to the Mopho hardware:

Copying groups of Programs works in the same way, but this time the location you select 
in the User Bank establishes where the fi rst Program in the group will be copied to. The fi rst Program in the group will be copied to. The fi rst
copied Programs will fi ll the User Bank from that point. A message box will display the 
range of User Bank locations that will be affected by the copy operation, and request 
your confi rmation before proceeding:

If the number of Programs to be copied exceeds the available space in a User 
Bank, the copy operation will be performed until the end is reached. For example, 
if you try to copy fi ve Programs from the Library into the User Bank starting at 
location 127, only the fi rst two Programs will be copied. These Programs will 
appear in locations 127 and 128; the other three Programs will be ignored.
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8.9 Bank Manager/Librarian Menus

File:

The File menu allows you to Load 
or Save all three Mopho banks, 
Load the Factory Programs of all 
three banks into the Bank Manager, 
access the Program Banks list, 
access the Phantom Program 
Banks function, and Quit the Bank 
Manager/Librarian. 

‘All Mopho Data’ fi les have 
the ‘.mph’ extension. To view a 
complete list of all SoundEditor fi le 
extensions, see Appendix A. 

Bank:

The Bank menu allow you to Copy, Rename or 
Initialize the currently selected Program,  Paste 
a previously copied Program, create a new 
(empty) Bank, and Load or Save the currently 
selected bank. 

The ‘Edit Program From Bank’ command sends 
the currently selected Program in the User Bank 
to the Mopho for editing. This is helpful to 
maintain synchronization between SoundEditor 
and the Mopho as you work with the Bank 
Manager.

The menus in the Bank Manager/Librarian allow you to select various functions, views, 
fi le storage options, editing commands, and much more. Descriptions of all Bank 
Manager/Librarian menus appears below.
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Librarian:

The Librarian menu allows you to Copy, 
Cut, Delete and Rename Programs, Paste 
a previously copied Program, create a new 
Library, Rename or Clear Categories, Load 
or Save Library fi les, and Load the Library 
from the User Bank (all 128 Programs), or add 
Programs from the Genetics ‘Top Offspring’ 
list.

The ‘Edit Program From Lib’ command 
sends the currently selected Program in the 
User Bank to the Mopho for editing. This is 
helpful to maintain synchronization between 
SoundEditor and the Mopho as you work with 
the Librarian.

Options:

The Options menu allows you to access the Genetics 
and Virtual Piano functions. 

Help:

The Help menu allows you to access additional assistance online.

MIDI:

The MIDI menu allow you to Receive or Transmit the 
currently selected bank, and access the MIDI Setup and 
Global Settings functions.

After selecting the ‘Load From User Bank’ command, you will be asked if you wish 
to sort the bank Programs into the corresponding Library categories. This option 
allows you to effi ciently organize groups of related Programs. Use it to collect and 
assemble your own custom sets of Bright Leads, Res Basses, etc.
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9. Program Genetics
The Program Genetics function allows you to quickly build new sounds from two 
existing ones in a similar fashion to breeding. Parameters of each of the two sources 
(“Parents”) are combined using four different functions to generate a new bank of presets 
(“Kids”). 

The Program Genetics window is selected from the Options menu of the main page
Program Genetics can also be accessed from the Bank Manager/Librarian Options
menu selection as well.

A view of the Preset Genetics window is shown below. The two source banks (called 
“Mommy” and “Daddy”) are located in the upper left, along with buttons for the four 
different Genetics functions. The generated bank (“Kids”) and the Top Offspring
bank are located in the lower left. On the right are fi lters to exclude selected parameters 
from the Genetics function, and three buttons at the top for editing functions and resetting 
excluded parameters.

Any pair of Programs can be used for the Genetics functions (that’s one Program each 
from Mother and Father). The result of applying the user-selected Genetics functions 
creates a child bank of 128 new programs, and any ‘keepers’ auditioned from the child 
bank can then be moved into the Top Offspring bank.
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Here’s what the four button functions do:

Mix: The parameters of each Child program are randomly chosen using 
parameters from either the Mother or Father. For example, if the Mother’s 
cutoff frequency was 10 and the Father’s was 88, the child’s value would
either be 10 or 88.

Morph: The value of each parameter is linearly interpolated from one
parent to the other. This means that the fi rst program in the ‘Kids’ bank is 
identical to the Mother while the last program is identical to the Father. All 
other Child programs are weighted towards a parent depending on their 
placement within the list. The middle Child Program (Program #64) is 
exactly 1⁄2 of the Mother and 1⁄2 of the Father Programs.

Mutate: The parameter values of each child Program are randomly chosen
from within the range between each parent’s parameter. For example, if
the Mother’s cutoff frequency was 10 and the Father’s was 88, Child values 
would be anywhere between 10 and 88.

Random: A random value from within the min/max parameter range
produces the value of each parameter for the Child.

The four Program Genetics functions are selected by using the buttons at the top of
the window. 

Experimentation using vastly different parents or similar parents creates the 
most interesting results. You can also ‘interbreed’ the child patches, too. In 
addition, you can set fi lters to excluded parameters that will not take a part in 
the generation of new offspring. Experiment and have fun!
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Additional controls appear on the top right side of the Program Genetics window:

The Auto Audition checkbox enables the transfer of selected Programs from the Mother, 
Father, Kids or Top Offspring banks to the Mopho’s edit buffer for auditioning. When the 
Auto Audition checkbox is unchecked (disabled), no Programs are transmitted.

The Edit button brings up the Editor window, permitting on-screen editing of a
selected Program from the Parents, Kids or Top Offspring banks.

The Write button brings up the Write Program dialog box. The Write function works
on the currently selected program, which can be from the Parents, Kids or Top Offspring 
banks.

The Reset button resets all checkbox selections made under the ‘Exclude Preset 
Parameters’ section. When you click Reset, all checked parameters become unchecked.

The Auto Audition button must be checked for the Editor to correctly display
the selected Program in the Genetics window.
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Both Parent banks use Programs from the ‘A’ bank by default, but any bank can
be loaded into either parent by clicking on the list box masthead and selecting
Bank A, B or C:

9.1 Selecting Parent Programs

To create a bank of sounds you must fi rst select a pair of ‘seed’ Programs, one each from 
the Mommy bank and Daddy bank. Use the scroll bars to scroll through the Parent bank
lists and select the desired Programs. To quickly advance through a bank list, place the 
cursor onto the list and use the scroll wheel on the mouse.

9.2 Creating New Sounds

Program names in the ‘Kids’ bank become 
scrambled or rearranged when you use the 
Genetics functions. This is normal.

With a pair of Programs chosen, selecting any one 
of the four Genetics functions (Mix, Morph, Mutate 
or Random) will create a bank of 128 programs in 
the Kids bank. Selecting function a second time will 
replace the previously generated Kids bank with a 
new bank of 128 programs
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As you audition Programs from the Kids bank, you will probably identify one or more 
Programs you wish to save or edit further. The Top Offspring bank provides a convenient 
place to ‘park’ these Programs. 

To copy Programs to the Top Offspring bank, you can either drag the selected Program 
into the Top Offspring window, or click on the large Copy arrow as shown:

9.3 Selecting Top Offspring

Programs in the Top Offspring bank can be edited directly (by selecting the Edit button) 
or loaded into the Librarian or Phantom Banks functions using the ‘load Top Offspring’ 
menu commands in those functions:

Also, when the Librarian and Program Genetics windows are both open, you can drag 
individual Programs from the Top Offspring list directly into any Librarian category.
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9.4 Program Genetics Menus

File:

The File menu allows you to quickly 
switch to the Bank Manager/Librarian 
function or to Phantom Program Banks. 
Selecting ‘Close’ closes the Program 
Genetics window and returns you to the 
Controls Window.

Edit:

The Edit menu allow you to clear the Programs in the Top 
Offspring bank. 

Since most of the control needed for Program Genetics operations are contained within 
the PG window, only a few additional menus commands are required. These are shown 
below.
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10. Morpher
The Morpher function allows you to blend or ‘morph’ any two Mopho Programs together 
to create a hybrid sound having the characteristics of both Programs. Functionally, 
Morpher is a subset of Program Genetics, but Morpher offers much more control over the 
morphing process.

The Morpher function is accessed by selecting ‘Morpher’ in the Options menu, or by 
clicking on the Morpher button in the main window. The Morpher window is shown 
below. 

When the Morphing function is accessed, the fi rst Program defaults to the currently 
selected Program, while the second Program is chosen using the Bank buttons and menu 
on the right. The Get button is used to change the fi rst Program should you select a 
different Program while the Morpher window is open.

The Slider is used to morph between the two Programs, and the resulting sound can be 
auditioned as you make adjustments in real time. 

When the Live Scroll option is checked, SoundEditor’s Control Window is continuously 
updated to show the parameter values as they change. You should also be aware that 
the Morphing process affects the Program name, so you’ll see scrambled or rearranged 
names in the Program Name display and also on the Mopho hardware. This is normal.

Clicking on the Add to Lib button adds the currently morphed Program to the Librarian 
in the active Library Category.

You should keep your speaker volume low when using the Morpher function,
as some high gain characteristics can result from the Morphing process.

The active Category defaults to ‘Not Assigned’ each time you launch 
SoundEditor and remains that way until you change it.
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The More button allows you to select additional Morphing options:

The checkboxes shown allow you to exclude certain parameters from the Morphing 
process. The term ‘base’ refers to the parameters in the fi rst Program:

Preserve Base Sequencer - Checking this box preserves the step settings of all 
four Sequencers. Sequence Destinations are not preserved.

Preserve Freq/Tune - Checking this box preserves Oscillator 1 & 2 Pitch and 
Tuning settings. Other Oscillator parameters are not preserved.

Preserve Base Oscillators - Checking this box preserves Oscillator 1 & 2 Pitch, 
Tuning, Waveform and Glide settings. Oscillator Mix and Sub-oscillator settings 
are not preserved.

Preserve Base Mod Sources - Checking this box excludes all four Sequencers 
from the Morphing process. Sequence Destinations are not preserved, however.

Preserve Base Mod Destination  - Checking this box preserves the four 
Modulation Destinations. 

Preserve Base Controls  - Checking this box preserves the destination and 
amount values of the fi ve MIDI Control parameters.

There is also the option to specify a MIDI Controller to act as the Morpher slider. 
Checking the Use Controller checkbox enables the selected MIDI Controller to control 
the Morphing process on the selected MIDI Channel.
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11. Snapshots
The Snapshots function allows you to quickly 
capture “Snapshots” of edited programs, providing 
multiple ‘undo’ points and allowing you to check 
your editing at various stages. It is a simple utility 
with a minimum of features, but it is invaluable in 
support of the editing/sound development process.

Snapshots is accessed by selecting the ‘View 
Snapshots’ option in the Snapshots menu. A view
of the Snapshots window is shown at left.

To capture a Snapshot of the current Program, simply click on the Snap button in the 
main window, or use the ‘Add Snapshot’ option in the Snapshot menu. Each time you 
capture a Snapshot it will be added to the Snapshots window.

To send a Snapshot to the DSI Mopho, click the Send button. As you build a list of 
Snapshots you may wish to go back to one of interest and perform additional edits. This 
is done by clicking on one of the Snapshots and clicking the Edit button. The parameter 
settings in Controls Window will reset to the selected Snapshot, and the Mopho hardware 
will update with those parameters values.
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12. Phantom Program Banks
The Phantom Program Banks function allows you to add virtual banks of programs
(called “Phantoms”) to your Mopho. Phantom Program Banks allows you to load up 
to 16 banks of Mopho Programs into SoundEditor, and have any Program in any bank 
immediately available for auditioning. This means you can have as many as 2048 
Programs (16 x 128) at your disposal (or 2432 Programs when you include the three 
Mopho Program banks). 

Banks of Programs can be loaded from SoundEditor’s Program Banks (A, B or C), or
from the Top Offspring list in the Program Genetics window, or from any previously 
saved bank fi les. Banks can also be assembled by pasting or dragging single programs to 
this window. 

Phantom Program Banks (PPB) is selected from the Editor’s File menu. The PPB window 
is shown below.



              

         

57

DSI Mopho SoundEditor -  Phantom Program Banks

58

DSI Mopho SoundEditor -  Phantom Program Banks

Other ‘hidden’ controls in the PPB window allow you to sort Program Banks in various 
ways. Program Banks can be sorted numerically, alphabetically or by category by 
clicking on ‘No.’, ‘Program’ or ‘Category’ headers. 

Finally, individual Programs can be sent to the Mopho hardware by selecting a Program 
and clicking on the Send arrow that appears in the far right column.

12.1 Window Operations

The Phantom Program Banks window has relatively few controls compared to other 
windows in SoundEditor:

The Add Current Program button adds the current preset from the User Bank to the 
active Phantom Bank. Note that new entries are always added to the end of the list, so if 
you have a lot of presets in a Phantom Bank, you may have to scroll down to see the new 
entry. Note also that since a bank consists of 128 Programs, clicking the Add Current 
Program button will have no effect if the bank is already full.

The Edit button takes you to the Controls window, where you can edit the currently 
selected Program.
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12.2 Phantom Program Banks Menus

PPB menus allow you to load Mopho Programs from within other SoundEditor functions, 
select fi le storage options, execute editing commands, and transfer Program banks. A 
description of the PPB menus appears below. 

File:

The File menu allows you to load Mopho Programs from multiple sources (Library 
fi les, User Bank fi les and Program Genetics Offspring), and save PPB Bank Library 
fi les.

Edit:

MIDI:

The Edit menu allows you to copy, paste, rename, 
and initialize individual Programs, as well as for 
clear the current Phantom Bank.

The MIDI menu allows you to transmit the current 
Phantom Bank to the selected Mopho Bank
(A, B or C). 
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13.1 V-Piano
The V-Piano provides a way to play the Mopho remotely using the mouse. When you 
press a  key on the virtual keyboard, the corresponding MIDI ‘Note On’ message will 
be sent to the Mopho. The note information will be displayed in red on the bottom 
left side of the keyboard, along with the MIDI channel and velocity information:

The ‘Vel’ Up/Down control on the far right of the V-Piano keyboard adjusts the note 
velocity (values from 1 to 127). The Midi channel is changed by clicking on the label 
just above the Velocity label and choosing from the popup contextual menu.

The virtual Pitch Bend and Mod Wheels can be used to control Pitch and Modulation 
functions as you play. 

SoundEditor offers additional remote controllers functions for the Mopho: a Virtual 
Piano (V-Piano), and the ability to play the Mopho from the computer keyboard. 
These functions allow you to remotely play the Mopho from within SoundEditor 
(handy if the Mopho is located more than an arm’s reach away from the computer). 
These functions are located in the Options menu:

13.  Additional Controls



              

         

59

DSI Mopho SoundEditor - Additional Controls

60

DSI Mopho SoundEditor - Additional Controls

Each keyboard press generates a MIDI Note ON message corresponding to the note 
as specifi ed. When the key is released, a MIDI Note OFF message is sent. 

Two computer keys are programmed to adjust octaves (increment/decrement):
  “p” – Octave up (one octave for each key press)
  “o” – Octave down (one octave for each key press)

You can switch octaves over a range of –2 to +8 (ten octaves total). When the octave 
switching keys are pressed, a pop-up window briefl y appears showing the change.

You can sustain a note by pressing down a “note” key and while it is depressed, 
press an “octave” key. A MIDI Note ON command will be sent without a 
corresponding MIDI Note OFF, causing a sustained, or ‘stuck’ note. To release the 
note, press the Space Bar. The Space Bar will send an ‘All Notes Off’ command 
that shuts off all MIDI notes.

Changing the velocity values using the computer keyboard is the same as 
changing ‘Piano Note Velocity’ in MIDI Setup Window.

Two computer keys are programmed to adjust note velocity (increment/decrement):
  “i” – Note velocity increases (+5 for each key press)
  “u” – Note velocity decrease (-5 for each key press)

Note velocities can be set from 0 to 125 in increments of 5. A note velocity of 0 is the 
equivalent of no note played. When the velocity switching keys are pressed, a pop-up 
window briefl y appears showing the change.

You can also play notes on the Mopho using the computer keyboard. The middle 
and bottom rows of computer keys act as a single octave of keys mapped like a 
piano keyboard. You can use these keys to remotely play notes on the Mopho. The 
computer key assignments are:

13.2  Playing the Mopho from the Computer Keyboard

The ability to play notes using the computer keyboard works in all SoundEditor 
windows, allowing you to audition sounds at anytime. Note, however, that the CAPS 
LOCK key must not be engaged (ON), as only the lower case letters will send MIDI 
note data. 

You can use the CAPS LOCK key to temporarily turn off remote playing if desired.
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Appendix A
File Extensions

SoundEditor uses the following fi le extensions to specify Mopho data:

Single Program Data = “.m_p”

All Mopho Data (Banks A, B & C) = “mph”

User Bank Data (Single Banks) = “m_b”

Library Data  = “.m_l”

Sequence Templates Data  = “.m_s”

Phantom Program Bank Data  = “m_b”



              

         

61

PC3 SoundEditor - File Extensions DSI Mopho SoundEditor - Sequencer Chord Structure

62

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 E4 C4 E4 C4 E4 C4 E4 C4 E4 C4 E4 C4 E4 C4 E4

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 E4 G4 C4 E4 G4 C4 E4 G4 C4 E4 G4 C4 E4 G4 C4

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 Eb4 G4 C4 Eb4 G4 C4 Eb4 G4 C4 Eb4 G4 C4 Eb4 G4 C4

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 G4 C5 E5 G5 C4 G4 C5 E5 G5 C4 G4 C5 E5 G5 C4

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 G4 C5 Eb5 G5 C4 G4 C5 Eb5 G5 C4 G4 C5 Eb5 G5 C4

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 E4 G4 Bb4 C4 E4 G4 Bb4 C4 E4 G4 Bb4 C4 E4 G4 Bb4

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 Eb4 G4 Bb4 C4 Eb4 G4 Bb4 C4 Eb4 G4 Bb4 C4 Eb4 G4 Bb4

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 G4 Bb4 C5 E5 G5 C4 G4 Bb4 C5 E5 G5 C4 G4 Bb4 C5

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

C4 G4 Bb4 C5 Eb5 G5 C4 G4 Bb4 C5 Eb5 G5 C4 G4 Bb4 C5

The Sequencer Function Panel in SoundEditor contains a number of preset ‘chords’ which are programmed 
as arpeggiated patterns of notes. These arpeggiated note patterns are shown below, grouped to show how 
the pattern repeats over the 16 sequence steps. All patterns are based on a starting note of C4, but the actual 
starting note is programmable, allowing you to create sequences in any key.

Appendix B
Sequencer Chord Structure

Basic (alternating major third):

Major:

Minor:

Major (2):

Minor (2):

Major 7:

Minor 7:

Major 7 (2):

Minor 7 (2):
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Appendix C
Sequencer Step Values

The following chart of step values is provided to assist in identifying and adjusting 
sequence pitches in SoundEditor. Step values are paired with the equivalent
MIDI note.

Step
Value

Note
Step
Value

Note
Step
Value

Note

0 C0 48 C2 96 C4

2 C#0 50 C#2 98 C#4

4 D0 52 D2 100 D4

6 D#0 54 D#2 102 D#4

8 E0 56 E2 104 E4

10 F0 58 F2 106 F4

12 F#0 60 F#2 108 F#4

14 G0 62 G2 110 G4

16 G#0 64 G#2 112 G#4

18 A0 66 A2 114 A4

20 A#0 68 A#2 116 A#4

22 B0 70 B2 118 B4

24 C1 72 C3 120 C5

26 C#1 74 C#3 122 C#5

28 D1 76 D3 124 D5

30 D#1 78 D#3 RST Reset 

32 E1 80 E3 OFF Rest

34 F1 82 F3

36 F#1 84 F#3

38 G1 86 G3

40 G#1 88 G#3

42 A1 90 A3

44 A#1 92 A#3

46 B1 94 B3

Print this page and keep it handy for working with sequences.
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Appendix D
MIDI Setup Options

The MIDI Setup menu provides tabs for confi guring the MIDI Port Connections and 
MIDI In Keyboard Controller options. MIDI Port Confi gurations are covered in the 
MIDI Setup section. This Appendix provides details on confi guring and using the 
MIDI IN Keyboard Controller and Virtual MIDI Port functions (the Virtual MIDI 
Ports only appears in the Macintosh version of SoundEditor).

The MIDI In Keyboard Controller function allows you to control the Mopho from 
another MIDI controller while SoundEditor is active. When enabled, the MIDI In 
Keyboard Controller function acts like a MIDI Merge utility, merging MIDI data 
from the controller device with editing data from SoundEditor. 

Only a few simple steps are required to confi gure the MIDI In Keyboard Controller 
function:

  1. Select the MIDI port that the controller is connected to.
  2. Make sure that the ‘Activate MIDI Controller Port’ checkbox is checked. 
  3. Set the MIDI Controller to the same MIDI channel as the Mopho.
  4. Test the setup. If the controller can send MIDI Note On messages, you can
   test the setup by playing a few notes. Otherwise, try sending an easily   
   discernible MIDI message, such a Program Change command.

MIDI In Keyboard Controller
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The Macintosh version of SoundEditor includes a Virtual MIDI Interface that allows 
you to connect the SoundEditor application between your MIDI Sequencer (Logic, 
ProTools, Cubase, etc.) and the DSI Mopho.  

In the MIDI Setup window, you’ll notice MIDI In Port and MIDI Out Ports labeled 
‘Mopho V– Output Port’ and ‘Mopho V– Input Port’ respectively. These ports are 
established by SoundEditor to provide a virtual MIDI bridge between it, your MIDI 
Sequencer and the Mopho:

NOTE:  Although they appear in the MIDI Setup list, the Virtual ports should never be 
selected. The Virtual ports are always active and are designed to be used exclusively 
by the MIDI applications that will be communicating with SoundEditor. You should 
select only the external (physical) ports that will be used for the connection between 
SoundEditor and the DSI Mopho.

Virtual MIDI Ports
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To confi gure your sequencer for this setup, you need to select “Mopho V – Output Port” 
as your sequencer’s MIDI Input port and “Mopho V – Input Port” as your sequencer’s 
MIDI Output port. With this setup, the sequencer will receive MIDI data from the Virtual 
Output and transmit MIDI data to the Virtual Input.

The Virtual MIDI Port function allows SoundEditor to interact with the Mopho while 
continuing to pass MIDI data to your MIDI Sequencer.
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Appendix E
Updating the Mopho OS

Updating the OS
The fi rst step in updating the Mopho OS is to get the update fi le. Go to:

   www.davesmithinstruments.com/support 

and download the OS update. This fi le will typically be a single ‘.syx’ fi le. Place the fi le 
on your desktop or in an easy-to-fi nd location on your computer, then follow these steps:

1. Begin by confi rming that MIDI connections are established and the correct MIDI  
    Ports are selected between SoundEditor and the Mopho hardware. If you have 
    used SoundEditor previously, these connections should already be established.

2. If you haven’t already done so, launch SoundEditor. After SoundEditor boots up, 
    select ‘Mopho OS Update’ from the Mopho menu:

IMPORTANT: Refer to the documentation supplied with your OS update for 
complete details on the update procedure BEFORE updating the fi rmware with 
SoundEditor.

This section will describe the process of updating the Mopho Operating System using 
SoundEditor. It is important that you heed all warnings and follow the procedure 
carefully to insure a successful update.
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    A small rectangular window will appear in the center of your screen:

    Click on the OS Update From File button. You will be presented with a ‘Load File’ 
    window. Navigate to where the Mopho OS Update fi le is located, select it, and click
    Open:

3. After the update fi le has been opened, a new window will appear.  Click on the Start
    button to begin the update. A ‘Transmitting OS...’ message will then appear as shown.
    Do not turn off the power and do not interrupt the process while the update is taking
    place:

    When the update process begins, the Mopho’s LED will display “Main OS Load” and
    count down for the duration of the update. When the countdown concludes, the
    Mopho will briefl y display a “Writing Now!” message. When the update is complete,
    the Mopho will reboot, SoundEditor’s ‘Transmitting OS...’ message window will be
    removed and normal operation will resume on both the Mopho and SoundEditor.


